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Introduction

Welcome to Checksum for the Macintosh, a complete file checksum program.
Checksum is a program that allows anyone to quickly and easily calculate file
checksums. Briefly, a checksum is a number calculated for a file by performing
some operation on all the characters in the file, such as adding up all the
character values and generating a total. A checksum is useful for testing the
integrity of a file — the calculated checksum can either be compared against a
previously calculated checksum, or the checksum can be compared against a
checksum for a file on another computer. Checksum is the easiest way to
compare two files on Macintosh computers (either on the same machine
or different ones), to tell if they are identical or not! If the checksum
values match, there is an extremely good chance the files are identical. The choice
of checksum algorithm affects the chance that two files are identical if their
checksums match.

Some of the key features of Checksum are:

• Most popular checksum algorithms are supported

• Checksum is compatible with most checksum programs on other
systems, e.g., the Unix “sum” program and the POSIX.2 “cksum”
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• Checksum can specially treat ‘TEXT’ file end-of-line characters to be
compatible with Unix or MS-DOS systems

• Checksum is fully System 7 and 32 bit addressing compatible, including
Apple Events, balloon help and “drag and drop”

• Checksum can calculate checksums for files, folders, volumes and even
alias files

• Checksum is business-ware — free for individuals and for education,
but organizations must pay if they use it

The results from Checksum are displayed in a window on the screen. Results can
be copied to the Clipboard to use in other applications.
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System Requirements

Checksum will run on a Mac Plus or later. System 6 or System 7 is required.

Trademarks

Apple and Macintosh are registered trademarks of Apple Corp.

Unix™ is a registered trademark of Unix System Laboratories, Inc.

MS-DOS®  is a registered trademark of Microsoft Corp.

Sun OS and Solaris are registered trademarks of Sun Microsystems

The MD5 Message-Digest Algorithm is by RSA Data Security, Inc.

All other trademarks held by their respective owners
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License Agreement and Registration Information

Please read this license carefully before keeping this software. By keeping and/or
using the software, you are agreeing to be bound by the terms of this license. If you
do not agree to the terms of this license, you are not authorized to use this software
and must delete it. Use and distribution of this software is governed by the
following terms to reasonably ensure this software will remain freely available
and that no one other than the author will derive a commercial benefit from
distributing this software.

“You,” “your,” and the “user” refers to any person or entity which acquires or uses
this software.

“Software,” “program” and “application” refers to any computer programs
identified at the start of this documentation file, together with all codes,
techniques, software tools, formats, designs, concepts, methods, ideas and
documentation associated with the computer program(s). The term also includes
all copies of any part of the software and documentation.

“Author” refers to the author of this software, Geoff Walsh.

License: The application and documentation accompanying this License, whether on disk, in
read only memory, or on any other media is licensed to you by the author. This software is
owned by the author and contains valuable and proprietary information of the author. You own
the disk on which the software is recorded.

This Checksum program for the Apple Macintosh, and its accompanying documentation, is
distributed as businessware. It is freeware for personal use on a single CPU and for
educational institutions to use for instructional uses. However, it must be licensed for use
within a business, corporation or organization. This includes government agencies. The
license fee is $10 U.S.  for each computer on which the application is used.

If you are a shareware distributor, you may distribute this software as long as you contact the
author for permission first. You must distribute all of the files intact and in unmodified form,
and may not charge more than a reasonable disk copying fee.

This software must be registered using the accompanying registration form and paying the
appropriate businessware fees. Individuals using the software for personal use and educational
institutions are encouraged to register their copies so they can be informed of future updates.

Restrictions: This software and documentation contains copyrighted material, trade secrets and
other proprietary material and in order to protect them you may not reverse engineer,
decompile, disassemble or otherwise attempt to convert the software to a human-perceivable
form. You may not modify, network, rent, lease, loan, distribute or create derivative works
based upon this software in whole or in part.

Termination: This License is effective until terminated. You may terminate this License at
any time by destroying the software and related documentation and all copies thereof. This
License will terminate immediately without notice if you fail to comply with any provision of
this License. Upon termination you must destroy the software and related documentation and
all copies thereof in your possession and cease distributing the same.

U. S. Government Restricted Rights: This software is provided with RESTRICTED RIGHTS.
Use, duplication or disclosure by the government is subject to restrictions set forth in
subparagraph (b)(3)(ii) of The Rights in Technical Data and Computer Software clause at
252.227-7013. Manufacturer is Geoff Walsh, P. O. Box 10, Malibu, California 90265-0010.
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Disclaimer of Warranty on Software: You expressly acknowledge and agree that use of this
software is at your sole risk. The software and related documentation are provided “AS IS ” and
without warranty of any kind and the author expressly disclaims all warranties, express or
implied, including, but not limited to, the implied warranties of merchantability and fitness for
a particular purpose. The author does not warrant that the functions contained in the software
will meet your requirements, or that the operation of the software will be uninterrupted or error-
free, or that defects in the software will be corrected. Furthermore, the author does not warrant
or make any representations regarding the use or the results of the use of the software or related
documentation in terms of their correctness, accuracy, reliability, or otherwise. No oral or
written information or advice given by the author shall create a warranty or in any way
increase the scope of this warranty. Should the software prove defective, you assume the entire
cost of all necessary servicing, repair or correction. Some states do not allow the exclusion of
implied warranties, so the above exclusion may not apply to you.

Although the author would appreciate any feedback or bug reports, the author shall not be
responsible for correcting any problems which you discover or otherwise help you maintain and
use this software. Furthermore, the author may at any time replace, modify, alter, improve,
enhance or change this software.

Limitation of Liability: Under no circumstances, including negligence, shall the author be
liable for any incidental, special or consequential damages that result from the use or inability
to use this software or related documentation, even if the author has been advised of the
possibility of such damages. Some states do not allow the limitation or exclusion of liability for
incidental or consequential damages so the above limitation or exclusion may not apply to you.

Controlling Law and Severability: This License shall be governed by and construed in
accordance with the laws of the United States and the State of California, as applied to
agreements entered into and to be performed entirely within California between California
residents. If for any reason a court of competent jurisdiction finds any provision of this
License, or portion thereof, to be unenforceable, that provision of the License shall be enforced to
the maximum extent permissible so as to effect the intent of the parties, and the remainder of
this License shall continue in full force and effect.

Complete Agreement: This License constitutes the entire agreement between the parties with
respect to the use of this software and related documentation, and supersedes all prior or
contemporaneous understandings or agreements, written or oral, regarding such subject
matter. No amendment to or modification of this License will be binding unless in writing and
signed by a duly authorized representative of the author.
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The Status Window Display

The status window is used to display the checksum results. The status window is
fully movable and resizable. The display can be scrolled if more information is
present than will fit within the window. The status window can only be written by
the checksum program — the keyboard cannot add to or modify its contents.
However, any information in the status display window can be selected and copied
to the Macintosh clipboard.

The status window will appear like:

Calculated
checksum value

Block count
(optional) Byte count

(optional)

Filename

Checksum cursor

The calculated checksum value is the result as a decimal number. This is what
the Checksum application calculates when a file is opened. If a CRC algorithm is
used, the result is also shown as a hexadecimal (base 16) value in parentheses.

The block count is the number of blocks in the file. This field is mostly for
compatibility with the Unix sum program. If the System V checksum algorithm
is used, the block size is 512 bytes; for all other checksum algorithms, the block
size is 1024 bytes.

The byte count is the number of bytes processed during the checksum calculation.
Note that this may not be the same as the number of bytes in the file, depending on
which file forks are selected and whether ‘TEXT’ file end-of-line translation is set
to MS-DOS.

The file name is simply the name of the file opened.
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Usage

Here are some possible ways to use Checksum:

1. Compare 2 files to determine whether they are the same or not.

Calculate the checksum for each file and compare the results. The files can be on
the same system, on different disks, or on two totally different machines (possibly
even in different countries). If the checksum for each file is the same, the files are
probably the same.

Make sure the same checksum algorithm is used on both files. For best results,
use any one of the 32-bit CRC options. Also, make sure that both Data fork and
Resource fork options are selected.

Both files don’t even have to be on Macintosh systems. For example, if one of the
files is on a Unix system, the “sum” command can be used to calculate a
checksum for one of the files.

2. Determine whether a file has changed over time.

If there is a file which may change over time, calculate the checksum for the file
and permanently record the results (e.g., with the Save As… option). When you
need to determine whether the file has changed, re-calculate the checksum for the
file and compare the two calculated values.

3. Calculate the checksum for an entire directory

In the Standard File selection dialog which appears when Open… is selected,
press the shift  key. The default Open button will change to Select. A folder,
volume or alias file can be selected. If a folder or volume is selected, a checksum
will be calculated for every file contained in the folder or volume.

System 7 users can also drag the folder or volume icon to the Checksum
application icon in the Finder. If you have used an earlier version of
Checksum, you will need to rebuild the desktop file for this feature to
work.  Press the command and option keys when you restart your Macintosh to
rebuild the desktop file.
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Menus

The File menu contains all the commands usually associated with opening and
saving files:

New will open a new status display window. Only one status display window can
be open at a time.

Open… will open a file and calculate a checksum. Results are presented in the
status window. A status window must be active in order to open files to calculate
checksums.

Pressing the shift  key will let you select a folder, volume or alias instead of the
normal open action. The Open button will change to Select and allow you to
select any special type of file.

Close will close the status window.
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Save As… will save the results in the status window to a file. The file will be a
text file which can be opened by an application such as TeachText.

Results… will present a dialog which lets you determine the location and format
of calculated results. Results can be saved as either reported text as in previous
version, or formatted for input to spreadsheet applications.

The default operation is for results to display on the screen, as in earlier versions.
When “Results to disk” is selected, all calculated checksum information is saved
directly to a disk file; a log of selected items is displayed on the screen. Note that
there is still a 32K limit on the size of the on-screen log, which should be adequate
for most applications.

Results can be save to disk in either ‘TEXT’ format, which is the same as in
earlier versions, or in delimited fields suitable for input to a spreadsheet
application. Spreadsheet column delimiters can be either tab, comma or carriage
return characters.

The file creator can be specified for text and spreadsheet formatted files. The
default creator for ‘TEXT’ files is TeachText/SimpleText (as in previous versions).
The default creator for “Spreadsheet” formatted files is Microsoft Excel. The
creator can be specified by either typing the 4 character creator string, or by
selecting the creator application using the standard file dialog. The file type will
be ‘TEXT’ for all files created.

The “Include column header” is not yet implemented. The “Other” disk format
option is not yet implemented. They are reserved for future capabilities.
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Quit will quit the Checksum application. Unsaved changes to the on-screen
window can be saved before the application quits.

Page Setup… and Print… aren’t implemented in this version of Checksum. If
you need to print Checksum results, Copy the status window display to the
clipboard, Paste into TeachText, a word processor or text editor, and print.
Alternatively, the saved results file can be printed from another application.
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The Edit menu contains the commands associated with the Macintosh clipboard.

Copy will copy the selected text to the clipboard.

Select All will select all the results in the status window. The Copy command
must still be used to copy all the text to the clipboard.

The Preferences… menu option provides a dialog which lets you choose specific
options depending on your needs. The default settings match earlier Checksum
versions.

Show Full pathnames will provide the complete path description for a file,
instead of just the base filename. Partial pathnames will display path names
relative to the folder selected. File names only will only show the base filename
as it appears in the standard open file dialog box.
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Report file forks separately will calculate checksums for each file fork
independently and report two separate values. Note that if ‘TEXT’ special has
been selected, both file forks will be reported, but only the data fork will have its
end-of-line character optionally translated. The data fork is calculated before the
resource fork.

Report folder totals will calculate an additional checksum for all the files in
the folder as if they were concatenated together. The are combined in the order
they are shown in the results.

Show file size in blocks will optionally report the block count. Similarly, Show
file size in bytes will optionally report the number of bytes in the file. If Report
file forks separately is selected, separate block and/or byte counts will be
reported for each file fork.

Report throughput will report the approximate performance of the checksum
algorithm for your system. Many factors will affect checksum throughput:
processor speed, disk I/O performance, operating system and extensions, and disk
cache settings. For best results, very large files will give the most accurate
measurements of actual performance, but results should be averaged over a large
number of files to get a meaningful measure for comparison purposes. The value
reported has little worth on its own.

Undo, Cut, Paste and Clear are not valid menu options, but are included for
compatibility with desk accessories.
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The Options menu controls how the checksum is calculated. The default settings
should provide maximum compatibility with the Unix “sum” utility.

System V will use the original AT&T Bell Labs checksum algorithm. This is not
a very “strong” checksum method, i.e., the chance of identical checksums for
different files is greater than for other algorithms. This algorithm is provided
mainly for compatibility with System V Unix implementations.

BSD will use the checksum algorithm traditionally found on Berkeley 4.x based
Unix systems (e.g., Sun OS/Solaris). On System V Unix implementations, the
“sum -r” command will usually produce the same values as this option.

CRC will use a stronger algorithm than either the System V or BSD options. Cyclic
Redundancy Check (CRC) checksums are a family of algorithms. The “CRC
Options” submenu is active only when CRC is selected. The “CRC Options”
submenu determines which CRC algorithm is used.

The RSA MD5 checksum option is a complete implementation of the RSA Data
Security, Inc. MD5 Message-Digest Algorithm. A message digest algorithm is a
cryptographic checksum that ensures even a small change in the input file
results in a large change in the calculated checksum. MD5 generates a 128-bit (16
byte) “signature” for any given file. MD5 is near the state of the art for
cryptographic checksum algorithms. It is conjectured that it is computationally
infeasible to produce two messages having the same message digest, or to produce
any message having a given prespecified target message digest. A complete
technical description of the MD5 algorithm can be found in Internet RFC 1321.

Data Fork will calculate a checksum value which includes the file’s data fork.

Resource Fork will calculate a checksum value which includes the file’s
resource fork. For consistency between files, the Finder Information portion of the
resource fork (bytes 16 to 127) is ignored in the checksum calculation.
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Note: when both “Data Fork” and “Resource Fork” are selected, the file is
treated as one contiguous file, with the file’s data fork immediately followed by the
file’s resource fork. This is not  the same as MacBinary format.

‘TEXT’ special determines whether files of type ‘TEXT’ will be treated specially. If
‘TEXT’ special is selected, the Macintosh end-of-line character (carriage return,
ASCII value 13, hexadecimal value 0D) will possibly be treated special for ‘TEXT’
files and only the data fork will be used, even if “Resource Fork” is selected. The
end-of-line character will be treated as selected in the “End-of-line mode”
submenu.
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The CRC Options submenu determines which CRC algorithm is used when CRC
is selected from the Options menu. Although the 32 bit CRC methods use the
same polynomial, initial values are different, which accounts for different results.

CRC 16 is the 16 bit CRC algorithm found in applications such as ARC. The CRC
polynomial used is: x16 + x15 + x2 + 1.

CCITT 16 is the 16 bit CRC algorithm defined by the CCITT international
standards group. (CCITT is the Consultive Committee for International
Telephone and Telegraph — a standards organization that sets standards for
worldwide voice and data communications.) The CRC polynomial used is:  x16 +
x12 + x5 + 1.

Zip 32 is the 32 bit CRC algorithm used in the Zip, Compact Pro and Brik
applications. The CRC polynomial used is:
x32 + x26 + x23 + x22 + x16 + x12 + x11 + x10 + x8 + x7 + x5 + x4 + x2 + x + 1.

POSIX.2 is the 32 bit CRC algorithm defined for use in the POSIX.2 “cksum”
utility. The CRC polynomial used is:
x32 + x26 + x23 + x22 + x16 + x12 + x11 + x10 + x8 + x7 + x5 + x4 + x2 + x + 1.
The POSIX.2 CRC algorithm is slightly different from the other CRC algorithms,
although the CRC polynomial is the same.

CCITT 32 is the 32 bit CRC algorithm defined by the CCITT international
standards group. The CRC polynomial used is:
x32 + x26 + x23 + x22 + x16 + x12 + x11 + x10 + x8 + x7 + x5 + x4 + x2 + x + 1.

The Custom 16, Custom 32 and Define… commands aren’t implemented in
this version. When implemented, they will support custom CRC calculations.

Many people has asked about the CRC calculation algorithms used in Checksum.
For any CRC polynomial, four values define the calculation: the CRC polynomial
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coefficients, the initial value, the byte ordering, and number of bits in the result.
The following table shows the information that describes the algorithms in
Checksum:

Name Coefficients
Initial
Value

Byte
ordering

No. of
bits

CRC 16 0xA001 0 swapped 16
CCITT 16 0x1021 -1 normal 16
Zip 32 0xEDB88320 -1 swapped 32
POSIX.2 0x04C11DB7 -1 normal 32
CCITT 32 0x04C11DB7 -1 normal 32

Coefficients  is the polynomial coefficients represented as a bit-map (in
hexadecimal). For example, 0xA001 is the polynomial x16 + x15 + x2 + 1 (note
the “+1” is always implied).

Note that the POSIX.2 algorithm differs slightly from the CCITT algorithm, even
though the polynomials are the same.
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The End-of-line mode submenu determines how the end-of-line character
(carriage return) will be treated when a ‘TEXT’ file is opened if “‘TEXT’ special”
has been selected from the Options menu. This will allow ‘TEXT’ files
transferred from another operating system to give the same checksum on the
Macintosh, even though some end-of-line conversion may have taken place.

Macintosh (CR) treats the end-of-line character as is, i.e., there is no conversion.

Unix (LF) treats end-of-line characters as a newline character (decimal 10,
hexadecimal 0A), instead of as a carriage return. The normal Unix end-of-line
character is a line feed.

MS-DOS (CR LF) treats end-of-line characters as a carriage return and line feed
pair. This is the normal MS-DOS end-of-line convention.
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Version History

Version 1.0 released March 1993. Initial release.

Version 1.1 released March 1994. RDA MD5 added, Preferences for display added,
improved performance slightly, all known bugs (minor) fixed, and more keyboard
functions supported. There are many changes internally to support future
upgrades.

Version 1.1.1 released June 1994. Two minor bugs fixed: version 1.0 preferences
are now read correctly, and the application now quits properly when settings have
been changed.

Version 1.2 released January 1995. This version now supports Apple Events and
the ability to select folders, volumes and alias files. Several minor usability and
performance improvements have been made. It now runs on System 6.0.2 and
6.0.3; the Preferences dialog now works on the Mac Plus and SE. Documentation
now in PDF format.

Version 1.3 released January 1996. New features include the ability to calculate
summary checksums for folders and volumes, formatted output suitable for input
to spreadsheet applications, no restriction on size of results, and support for
background processing.
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Future enhancements

This is version 1.3 of Checksum. Depending on support and user feedback, it will
be enhanced and maintained. This is still very much a work in progress and the
priorities for new features depend on user feedback and support.

Some of the planned enhancements include:

PowerMac native version

Printing

Custom CRC definition and calculation

Improved user interface for results display

Better support for AppleScript

Saving calculated checksums in a reference file for automated comparison
to validate file integrity.

Please send suggestions for improvements you would like to see.

If you use this software and want to see these future enhancements, please
consider becoming a registered user.
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Questions or Problems?

Verify that you have a good copy of the program. When you receive Checksum and
do Get Info from the Finder’s File menu, you should see:

In its default configuration, Checksum version 1.3 will calculate a checksum for
itself which should be:

41556    57 blocks,    58078 bytes “Checksum”

If your results don’t match this, your copy has been modified and is not valid.

If you have already been using the checksum program, make sure you are using
the correct configuration. Remove the “Checksum Preferences” file in your
System Folder (System 6) or System Folder’s Preferences folder (System 7). Be
sure to rebuild the desktop file on your Macintosh.

Checksum has been tested on most Macintosh models running both System 6 and
System 7 and is 32-bit clean. If you encounter problems, try restarting your
computer will all INITs and Extensions disabled. If the problem persists, please
contact me. For correspondence by U.S. mail, use:

Geoff Walsh
P. O. Box 10
Malibu, CA  90265-0010

For electronic correspondence through the Internet, use: gpw@cerf.net.
If you want extensive support, please register your software.
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Registration
Checksum for the Macintosh

Version 1.3

Thank you for your support. Be sure to register Checksum if you use it. Print this page and
return with the appropriate businessware fees to: Geoff Walsh

P. O. Box 10
Malibu, CA  90265-0010

Name:

Organization:

Address:

City, State, Zip code and Country:

Electronic mail address:

Macintosh model:

System software version:

Where did you get this copy of Checksum?

Businessware Fees: Users of earlier versions are automatically
registered.

Personal/Educational       copies x $0 U.S. = 0
1 to 49       copies x $10 U.S. =
50 to 449 $400 site license =
450 or more $750 site license =
Printed manual & disk       copies x $20 U.S. =

Total =
❏ Check here if you need a receipt

Sorry, no credit cards yet

Comments and suggestions:
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